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1 Introduction to the Manual 

1.1 About this User Manual 

1.1.1 The purpose of this Manual 

Audience 

This User Manual is intended for designers using the TraSiS V4.1 software program for the design of 
roadside sign support structures. 

Reader skills 

The User Manual assumes that the reader has a basic knowledge of the sign design procedures as 
outlined in Transport and Main Roads' Traffic and Road Use Management (TRUM) manual Volume 3 
Signing and Pavement Marking Part 5 Design Guide for Roadside Signs. 

Expected outcome 

After studying this User Manual, the reader should be able to: 

• create a new sign structure 

• understand the sign storage feature 

• print forms, and 

• interpret warnings and errors. 

1.1.2 Acronyms used in this User Manual 

The acronyms in this User Manual are listed in Table 1.1.2: 

Table 1.1.2 – Acronyms 

Acronym Details 

AADT Annual Average Daily Traffic Flow 

CHS Circular Hollow Section 

RHS Rectangular Hollow Section 

TraSiS Traffic Sign Structures 

1.1.3 Referenced documents 

• Standard Drawing SD1363 Traffic Sign  – Multiple Traffic Sign Support 

• TRUM Volume 3 Signing and Pavement Marking Part 5 Design Guide for Roadside Signs. 

https://www.tmr.qld.gov.au/business-industry/Technical-standards-publications/Standard-drawings-roads/Standard-drawings-index
https://www.tmr.qld.gov.au/business-industry/Technical-standards-publications/Traffic-and-Road-Use-Management-manual/Volume-3
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2 Introduction to TraSiS 

TraSiS V4.1 is a program developed by the Department of Transport and of Main Roads to assist in 
the design of roadside sign support structures. It is used in conjunction with TRUM Volume 3 Part 5. 

Installing TraSiS 

Download the TraSiS application zip file (32-bit or 64-bit options) from the Department of Transport 
and Main Roads website https://www.tmr.qld.gov.au/business-industry/Road-systems-and-
engineering/Software/TraSiS to an appropriate folder on your hard drive. Extract the zipped files from 
that folder and run the TraSiSSetup.exe file or TraSiSSetup_x64.exe file. The program will 
automatically download and create a new default folder called 'TMR' in C:\Program Files (x86) located 
on your hard drive. 

After installation is complete, you will see the screen shown in Figure 2. 

Figure 2 – Installation screen 

Select Close to begin using the program. Once the program is loaded, the Title bar becomes active 
and the main menu available.

https://www.tmr.qld.gov.au/business-industry/Road-systems-and-engineering/Software/TraSiS
https://www.tmr.qld.gov.au/business-industry/Road-systems-and-engineering/Software/TraSiS


Traffic sign structures (TraSiS V4.1) 

User manual, Transport and Main Roads, December 2020 3 

2.1 Menus 

If you are a first-time user, take some time to become familiar with the menus shown in Figure 2.1. 

Figure 2.1 – Main menu 

2.1.1 File menu 

To create a new sign, select New as shown in Figure 2.1.1(a). 

Figure 2.1.1(a) – New 
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To open a file created previously, select Open as shown in Figure 2.1.1(b). 

Figure 2.1.1(b) – Open 

To close a current file, select Close as shown in Figure 2.1.1(c). 

Figure 2.1.1(c) – Close 

To save a current file, select Save as shown in Figure 2.1.1(d). 

Figure 2.1.1(d) – Save 
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To save a new sign in the current database, select Save As as shown in Figure 2.1.1(e). 

Figure 2.1.1(e) – Save As 

To rename a sign, job section or an entire job, select Rename as shown in Figure 2.1.1(f). 

Figure 2.1.1(f) – Rename 

To delete a previously saved file, select Delete as shown in Figure 2.1.1(g). 

Figure 2.1.1(g) – Delete 

 



Traffic sign structures (TraSiS V4.1) 

User manual, Transport and Main Roads, December 2020 6 

To print out a design form, order form or summary form, select Print as shown in Figure 2.1.1(h). 

Figure 2.1.1(h) – Print 

To exit the TraSiS program, select Exit as shown in Figure 2.1.1(i). 

Figure 2.1.1(i) – Exit 

2.1.2 Edit menu 

The following information is available from the Edit menu. 

Select Sign details as shown in Figure 2.1.2(a) to edit the current job description, sign faces and 
roadside slope. 

Figure 2.1.2(a) – Sign details 
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Select Environmental conditions as shown in Figure 2.1.2(b) to specify wind region, foundation 
ground type and situation risk. 

Figure 2.1.2(b) – Environmental conditions 

Use TRUM Volume 3 Part 5 or customised settings when selecting Stiffener spacing as illustrated in 
Figure 2.1.2(c). 

Figure 2.1.2(c) – Stiffener spacing 

Select Notes as shown in Figure 2.1.2(d) to assign general comments and notes. These notes are 
printed with the Design form. 

Figure 2.1.2(d) – Notes 

Select Clear zone as shown in Figure 2.1.2(e) to calculate the appropriate clear zone distance for the 
road. 

Figure 2.1.2(e) – Clear zone 
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Select Default values as shown in Figure 2.1.2(f) to assign Default values to Sign position and 
Clear zone parameters. 

Figure 2.1.2(f) – Default values 

2.1.3 Help menu 

Figure 2.1.3 shows the information available from the Help menu. 

Figure 2.1.3 – Help: About TraSiS 
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3 Design procedures 

3.1 Sign details entry form 

From the File menu or the Main window, select the New command as shown in Figure 3.1(a). This 
launches the Sign details entry form. 

Three tabs will be visible: 

• Job details 

• Roadsides slope; and 

• Sign panels. 

Figure 3.1(a) – Job details 

All information boxes must be filled in before proceeding to the next tab. Use the Previous and Next 
buttons to navigate between the three tabs. 

TraSiS stores all signs in a database. Each sign is distinguished by Job section and Sign position 
(location), allowing for simple and effective organisation of sign storage. 

A Design status area indicates possible duplication of name allocations and validation of new design. 

Up to five slope segments of variable length and height can be used to model a particular roadside 
cross-section. In addition, the longitudinal details of the slope segments can be specified (this is useful 
when examining the feasibility of strut sport signs: for example, where there are longitudinal 
differences in post location). 
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Figure 3.1(b) illustrates an example of defining the road geometry to record roadside slope details. 

Figure 3.1(b) – Roadside slope details: Define the roadside geometry 

A sign structure can support up to four separate panels (three facing the front and one facing the rear), 
each panel having individual dimensions, and road clearance. Refer to TRUM Volume 3 Part 5 for 
information regarding sign face design. Figure 3.1(c) illustrates specifying the details of the sign face 
for sign panels. 

Figure 3.1(c) – Sign panels: Specify the details of the sign face 

Once all sign details forms are complete, the OK button becomes available. Pressing the OK button 
launches the next form, Roadside environment. 

3.2 Roadside environment entry form 

Once all Sign details forms are complete and the OK button is pressed, the Roadside environment 
form will appear, as shown in Figure 3.2(a). 

Three tabs will be visible: 

• wind region 

• soil type, and 

• slip base. 
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The wind regions range from A to D, A being for areas which generally experience normal wind 
conditions and D being for areas that are subject to severe cyclones. Select the geographic wind 
region in which the sign is to be built. 

Figure 3.2(a) – Roadside environment form 

The wind region map illustrated at Figure 3.2(b) indicates the geographic regions associated with the 
scale. Locations that are exposed to higher winds than what is usual for the locality (for example, 
coastal highways) are accommodated by selecting the Exposed location check box. Refer to 
TRUM Volume 3 Part 5. 

Figure 3.2(b) – Wind region 

 

Zoom function 

Click on the Guide to 
Wind Regions button for 
map of wind regions in 
Australia 
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Select Soil type as shown in Figure 3.2(c) to record the soil type that most accurately describes the 
soil at the location. 

Figure 3.2(c) – Soil type 

Select Guide to foundation strength selection as shown in Figure 3.2(d) for a description of each 
soil type (field and scientific identification) to help select the appropriate type. 

Four tabs will be visible: 

1. clay soil – firm to stiff 

2. clay soil – stiff to hard 

3. sand – loose to medium dense; and 

4. sand – dense. 

Figure 3.2(d) – Guide to foundation strength selection 
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Select the soil type that most accurately describes the soil at the location as shown in Figure 3.2(e). 

Figure 3.2(e) – Soil description 

Select the Slip base tab as shown in Figure 3.2(f) to record risk options. 

Figure 3.2(f) – Slip base 

If the sign is to be erected in an area where there is a high risk of impact (that is, within the Clear zone 
distance), select Slip base; otherwise, select Rigid base. Refer to TRUM Volume 3: Part 5 for further 
information. 
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4 Main window 

Figure 4(a) shows the different elements displayed in the Main window. The Main window gives a 
clear display of the most important elements of the sign. The left half of the screen displays technical 
design data, while the right half displays a graphic view of the sign in relation to the ground and road. 

Figure 4(a) – Main window 

Some of the data fields are variable within a certain range. Selecting the up or down arrow as 
illustrated in Figure 4(b) allows adjustments to that field parameter. 

Figure 4(b) – Data field adjustment 
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4.1 Technical design data 

4.1.1 Support details 

The Number option illustrated in Figure 4.1.1(a) details the number of support posts and is the option 
to select to change the number of posts that may be varied. 

Figure 4.1.1(a) – Number of support posts 

Highlighting and typing value or clicking the up arrow will change the number of posts, as shown in 
Figure 4.1.1(b). This may be varied within a certain range. 

Figure 4.1.1(b) – Adjust number of posts 
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Post spacings will also change with post numbers, as shown in Figure 4.1.1(c). A standard Spacing 
determined by the number of posts will initially be displayed. 

Figure 4.1.1(c) – Spacing between the support posts 

Selecting other spacings is allowed, as shown in Figure 4.1.1(d), and a Reset option returns to the 
standard spacings. 

Figure 4.1.1(d) – Adjust post spacing 
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Clearance above road edge details the height of the sign from the road surface to the bottom of the 
sign, as shown in Figure 4.1.1(e). 

Figure 4.1.1(e) – Clearance above road edge 

Highlighting and typing value or clicking the arrows, as shown in Figure 4.1.1(f), will change height as 
required. The initial height of the sign is set according to the default settings (see Figure 2.1.2(f)). 

Figure 4.1.1(f) – Adjust clearance above road edge 
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Distance from carriageway, as illustrated in Figure 4.1.1(g), details the lateral clearance between the 
part of the sign nearest to the road and the edge of the kerb, or pavement. 

Figure 4.1.1(g) – Distance from carriageway 

Highlighting and typing value or clicking the arrows will change distance as required, as shown in 
Figure 4.1.1(h). The initial distance of the sign from the road edge is set according to the default 
settings (see Figure 2.1.2(f)). 

Figure 4.1.1(h) – Adjust distance from carriageway 
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Kerb post length, as illustrated in Figure 4.1.1(i), refers to the length of the post nearest the kerb (not 
including section underneath slip base or screw footing). 

Figure 4.1.1(i) – Kerb post length 

Post lengths 2, 3 and 4, as illustrated in Figure 4.1.1(j) refers to the length of the second, third and 
fourth nearest post to the kerb (not including section underneath slip base or screw footing). 

Figure 4.1.1(j) – Post lengths 

 



Traffic sign structures (TraSiS V4.1) 

User manual, Transport and Main Roads, December 2020 20 

Stub length, as illustrated in Figure4.1.1(k), refers to the length of the post stub that sits inside the 
screw (if a screw footing is used), or that remains below the slip mechanism (if a slip is used). 

Figure 4.1.1(k) – Stub length 

The Post dimensions option is illustrated at Figure 4.1.1(l). For Circular Hollow Section (CHS), the 
measurement is the external diameter of the posts. For Rectangular Hollow Section (RHS), the 
measurement is the rectangular cross-section of the post. 

Figure 4.1.1(l) – Post dimensions 
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Post wall thickness, shown at Figure 4.1.1(m) refers to the thickness of the wall material. 

Figure 4.1.1(m) – Post wall thickness 

Post grade, shown at Figure 4.1.1(n), refers to the grade of steel used for the post. 

Figure 4.1.1(n) – Post grade 
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Slip base required, as shown in Figure 4.1.1(o), indicates previous selection of post without Slip 
Base. This would be Yes if Slip Base was initially selected. 

Figure 4.1.1(o) – Slip base required 

Stiffener type, illustrated at Figure 4.1.1(p), shows one of two types of stiffener, designated as Type 1 
and Type 2. 

Figure 4.1.1(p) – Stiffener type 
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4.1.2 Footing details 

Support foundations – Normal, as shown in Figure 4.1.2(a) shows the diameter of the hole for 
normal concrete footings / diameter of screw. 

Figure 4.1.2(a) – Diameter of hole / screw 

Click the tab for Support foundation to launch the dialogue box. Select either Normal or Screw 
footing as shown in Figure 4.1.2(b). 

Figure 4.1.2(b) – Change footing type 
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Support foundations – Screw, illustrated in Figure 4.1.2(c) shows the depth of hole from the surface 
to the end of the post, not including the depth of concrete underneath the post / length of screw. 

Figure 4.1.2(c) – Depth of hole / length of screw 

4.1.3 Sign and stiffener details 

As shown in Figure 4.1.3(a), moving the cursor over each Panels and stiffeners sign box displays a 
small window that shows information relevant to each sign face. 

Figure 4.1.3(a) – Sign and stiffener details 

To adjust the method by which the required number of stiffeners is calculated, select Stiffener 
spacing options from the Edit menu as shown in Figure 4.1.3(b). 

Figure 4.1.3(b) – Stiffener spacing options 
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Selecting Stiffener spacing options from the Edit menu will launch the Stiffener spacing dialog box, 
shown in Figure 4.1.3(c). Spacings and distances may be varied within a certain range by clicking on 
the arrows. 

Figure 4.1.3(c) – Stiffener spacing 

TraSiS automatically calculates the most efficient stiffener configuration base on the settings in this 
form. 

Additionally, provision is made for users to specify custom settings by adjusting the values above and 
selecting the lowest button of the three: Use custom settings. 

4.1.4 Post type selection 

Refer to TRUM Volume 3 Part 5 for instructions on the selection of appropriate post sections. 

It is not always possible to construct a sign using a particular post type. 

Support posts – CHS steel, illustrated in Figure 4.1.4(a), specifies that the post(s) be made of 
circular hollow section. Refer to Standard Drawing SD1363. 

Figure 4.1.4(a) – Circular hollow section steel 

Support posts – RHS steel, illustrated in Figure 4.1.4(b), specifies that the post(s) be made of 
rectangular hollow section. Refer to Standard Drawing SD1363. 

Figure 4.1.4(b) – Rectangular hollow section steel 
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4.1.5 Message box 

The Message box, shown in Figure 4.1.5, displays any warning or errors regarding the structural 
design. Most warnings are to inform that various aspects of the sign do not meet standard guidelines. 
Others indicate that no standard sign structure is possible for the specified conditions. The red post 
signifies an error in post length. 

Figure 4.1.5 – Message box: warnings and / or errors 
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5 Sign storage 

5.1 Storage department 

TraSiS stores all of its signs in a database format organised by job, section and location, as shown in 
Figure 5.1(a). 

Figure 5.1(a) – Database 

To rename a Sign, Job Section or an entire Job, click on the required folder icon in the stored signs 
area, then click on the name of the file, now bolded. Type in the new name as required and click the 
Rename button, as shown in Figure 5.1(b). 

Figure 5.1(b) – Renaming 

The Job management feature, shown in Figure 5.1(c), selects which jobs appear in the storage 
department windows, preventing the window from becoming crowded with older jobs. 

Clicking the Job management button will launch a dialog box from where the job codes can be 
enabled (displayed in the Load a sign structural design box) or disabled (hidden). 

Once modified, clicking the OK button will close the dialog box. 
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The Job management dialog box shows the particular database location and permits relocation of 
files. 

Figure 5.1(c) – Job management 

The database that stores the signs can be found as a gsddb.mdb file, residing in the TraSiS directory. 
The sign storage commands are accessible from the File menu, as shown in Figure 5.1(d). 

Note: The EXAMPLE database is read-only and any new signs need to be saved in a custom created 
database (see Section 5.2). 

Figure 5.1(d) – Storage commands 

Extra databases can be developed, by copying, renaming and then editing the original database as 
necessary. A new database can also be created from the browse button in the job management 
dialogue, simply by navigating to the relevant folder and typing in the new filename. This would avoid 
having to copy and edit the original database. 

These databases may then be retained or transferred to other locations by copying the relevant 
database gsddb.mdb file. Selection of a particular database can then be made from the relevant 
.mdb files in the TraSiS directory. 

5.2 How to save a sign in a custom database 

In order to save a newly created sign, click on File, Save As, Job Management, as shown in Figure 
5.2(a). 
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Figure 5.2(a) – Step 1 

 

Then click on the three ("…") as shown in Figure 5.2(b). 

Figure 5.2(b) – Step 2 

 

Browse to a location on your hard drive or network drive different than the location of the default 
database. Enter the name of the new database and click Open, as shown in Figure 5.2(c). 
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Figure 5.2(c) – Step 3 

 

Click Yes on the following screen as shown in Figure 5.2(d). 

Figure 5.2(d) – Step 4 

 

Click OK on the following screen as shown in Figure 5.2(e). 

Figure 5.2(e) – Step 5 

 

Click Save As, as shown in Figure 5.2(f) and the sign will be saved in the newly created database. 
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Figure 5.2(f) – Step 6 
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6 Clear zone 

6.1 Understanding clear zone 

The purpose of the Clear zone is to minimise the risk for errant motorists by establishing a minimum 
distance beside the road that must be clear of obstructions. TraSiS automatically calculates the 
appropriate clear zone distance for a roadside cross-section while taking into account parameters 
such as speed environment, road curvature and Annual Average Daily Traffic Flow (AADT). The clear 
zone distance is not a precise measurement; rather, it is an indicative guide to assist in the application 
of engineering judgement to a particular situation. 

The clear zone module is launched from the Edit menu, as illustrated in Figure 6.1(a). 

Figure 6.1(a) – Clear zone 

Figure 6.1(b) illustrates the clear zone module screen. 

Figure 6.1(b) – Clear zone module 
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6.2 Clear zone window 

As shown in Figure 6.2, the window is divided into two main sections; a graphical display of the 
roadside on the left, and a column on the right that contains controls for the clear zone parameters 
and other data displays. 

Figure 6.2 – What is seen 

6.2.1 Parameters 

As shown in Figure 6.2.1(a), use the check box to indicate whether the road is on a curve or not, and if 
so, adjust the curve radius using the scroll bar. Road curvature with radius greater than 900 m is 
considered to be comparatively straight, while a minimum radius of curvature exists for each speed 
environment. 

Figure 6.2.1(a) – Road curvature 

As shown in Figure 6.2.1(b), Barrier distance specifies if a barrier is employed on the roadside and, if 
so, the distance from the roadside to the barrier that can be adjusted using the scroll bar. 
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Figure 6.2.1(b) – Barrier distance 

As shown in Figure 6.2.1(c), Speed environment is either the 85th percentile speed of all traffic on the 
road, or if this is unavailable, then the posted speed limit. 

Figure 6.2.1(c) – Speed environment 

As shown in Figure 6.2.1(d), Annual Average Daily Traffic Flow (AADT) is traffic volume in units of 
vehicles per day. 

Figure 6.2.1(d) – Annual Average Daily Traffic Flow 

6.2.2 Clear zone distance 

As shown in Figure 6.2.2(a), Clear zone distance – level terrain is the calculated clear zone distance 
for a level slope using the given parameters. 

Figure 6.2.2(a) – Level terrain 

As shown in Figure 6.2.2(b), Clear zone distance – actual terrain is as Clear zone distance – level 
terrain but considers the slope details as specified for the sign location. Currently, no algorithm exists 
to calculate clear zone distance for sections with both cut and fill slopes; therefore, in this 
circumstance, TraSiS returns a message indicating that the slope section is too complicated to 
analyse. 

Figure 6.2.2(b) – Actual terrain 
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7 Printing 

7.1 Accessing the print commands 

TraSiS includes three different Print forms: 

• Design form 

• Order form; and 

• Summary form. 

As shown in Figure 7.1, select the appropriate form using the Print option from the File menu. 

Figure 7.1 – Printing forms available 

7.1.1 How to print design and summary forms 

Clicking on one of the three options available will launch the Print job selection form shown in 
Figure 7.1.1(a). This procedure is common for printing any of the three forms; however, the procedure 
varies slightly form this point forward, as shown in sections 7.1.1(b)–(d). 

On the Print job selection form to select the sign for printing, follow the steps: 

1. Click the appropriate Job code section and Position. 

2. Information on the Current print status will appear. 

3. Click the Add button to locate the sign in the Signs selected to print box. 

4. Click the Print setup button to set the printer requirements. 

5. This will then launch the Print setup menu box. 

6. Select printer settings. 

7. Click OK to close the Print setup box. 

8. Return to the Print job selection form. 

9. Select OK to print. 
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Figure 7.1.1(a) – Print selection 

Figure 7.1.1(b) shows a sample Design form. 

Figure 7.1.1(b) – Print job selection: Design form 
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Figure 7.1.1(c) shows the Notes page which is printed along with the Design form. 

Figure 7.1.1(c) – Notes page 
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Figure 7.1.1(d) shows the Summary form which contains structural data for each sign in a condensed 
form under the headings: 

• position number 

• sign code 

• sign details 

• stiffener details 

• support details 

• support length details 

• stub, and 

• footing details. 

The form fits the details of up to 40 signs per page, arranged according to Job. 

Figure 7.1.1(d) – Summary form 
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7.1.2 How to print order forms 

The Order form shown in Figure 7.1.2 contains all data necessary to order the correct structural 
members:  

• requisition number (see Note); 

• job code, job section and sign position 

• sign face details 

• stiffener details 

• support details 

• stub details, and 

• fitting details. 

Note: The form fits details of up to 10 signs per page. 

The print process includes a prompt for the requisition number that appears at the top of the page. 

Figure 7.1.2 – Order form 
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8 Warnings and errors 

TraSiS communicates warnings or errors through the Message box. Following are some commonly 
displayed warnings and errors. 

Table 8 – Warnings and errors 

Warning or error Probable cause 

Insufficient terrain information has been defined. Total horizontal length of the roadside slope is 
less than the width of the sign face. 

A combination of large sign area and/or high 
clearance height has resulted in no solution 
being found for the stated Wind region and 
Exposure settings. 

This error generally occurs on signs with large 
areas and heights, especially with strut signs – 
not always literal. 

Only one front sign is allowed for truss designs. The user is attempting to view a truss structure 
for two or more sign faces. 

Only normal concrete footings are allowed for 
truss designs. 

The user is attempting to use screw footings on 
a truss support. 

Post 2 clearance is x and needs to be at 
least 1500. 

The minimum post clearance is required for the 
safety and courtesy of pedestrian traffic. Post 
clearance is calculated by subtracting 175mm 
from the road height. 

Post 1 clearance is x and needs to be at least 
2100. 

As stated previously; however, greater 
clearance is required for slip base signs. 

Post 2 clearance is x and needs to be less than 
10,000. 

The maximum post clearance for CHS and RHS 
posts is 10m. 

Post spacing must be greater than 1500mm for 
slip base supports – signs less than 1700mm 
that require two posts may be excluded. 

Post spacing is critical for only slip base signs. 
Note: For some situations, it may not be possible to 
find a suitable design that can be built inside a clear 
zone. 

Post spacing is too wide for the smallest signs' 
width 

For a sign panel, the minimum overhang 
beyond the supports is 100mm 

Post 2 clearance is x and needs to be less than 
3250. 

The maximum post clearance for truss posts is 
3250mm 

Design eccentricity is too large (difference 
between tallest and shortest posts). 

In a strut support sign, the difference in length of 
any two posts cannot be more than 500mm. 

Cross-section data are too complicated to 
analyse. 

When the roadside cross-section has both cut 
and fill slopes, this message appears in the 
Clear zone window. 

Sign panel height is greater than twice the 
clearance height. A slip base design is not 
possible for this situation. 

For slip base designs, the clearance height 
must be more than half the sign panel height 

Sign is too wide to be handled by this program. Sign width must be less than, or equal to 
9600mm. 

I can't save a sign to the default database. The default (EXAMPLE) database is read-only 
and any new signs need to be saved in a 
custom created database (see Section 5.2) 
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